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Preface

Intended Audience
Welcome to Release 11i of the Oracle Mobile Field Service User Guide for Laptops. This 
guide describes how to use the Oracle Mobile Field Service/Laptop application. It 
also describes the application components, key concepts, features, and functions, as 
well as the application’s relationships to other Oracle or third-party applications. 

To use this guide, you should have a working knowledge of the following:

� The principles and customary practices of your business area 

� Oracle Mobile Field Service

See "Other Information Sources" for more information about Oracle applications 
product information.

If you have never used Oracle Mobile Field Service, Oracle suggests you attend one 
or more of the Oracle Mobile Field Service training classes available through Oracle 
University.

How To Use This Guide
This guide contains the information you need to understand and use Oracle Mobile 
Field Service/Laptop.

� Chapter 1, "Understanding Oracle Mobile Field Service/Laptop" describes what 
Oracle Mobile Field Service/Laptop is and how to administer it. This chapter 
also describes how the application is structured and how you can navigate in it.

� Chapter 2, "Installing Oracle Mobile Field Service/Laptop" describes what is 
needed to install and use the Oracle Mobile Field Service/Laptop application. It 
also describes how to launch the application.



viii

� Chapter 3, "Using Oracle Mobile Field Service/Laptop" describes how to use all 
the functionality associated with the navigational tabs in the application.

� Appendix A, "Setting up Schedules and Responsibilities" describes the different 
levels of control field service representatives can exercise when doing their job.

Typographic Conventions
The following table describes the typographical conventions used in this guide:

Documentation Accessibility 
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 
markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle Corporation is actively engaged with other 
market-leading technology vendors to address technical obstacles so that our 
documentation can be accessible to all of our customers. For additional information, 
visit the Oracle Accessibility Program Web site at 
http://www.oracle.com/accessibility/

Conventions Explanation

italics Introduces new terms that you may not be familiar with, and is 
used occasionally for emphasis.

bold Emphasizes important information. Also indicates button or 
option selections. For example, click Next.

UPPERCASE Indicates the name of a file. For operating environments that use 
case-sensitive file names, the correct capitalization is used in 
information specific to those environments.

Also indicates keys or key combinations that you can use. For 
example, press the ENTER key.

monospace Indicates syntax examples, values that you specify, or results 
that you receive.

monospaced italics Indicates names that are placeholders for values you specify; for 
example, filename.

> Indicates a selection from a menu. For example, Start > 
Programs > Oracle for Windows NT > Web-to-Go
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Accessibility of Links to External Web Sites in Documentation This 
documentation may contain links to Web sites of other companies or organizations 
that Oracle Corporation does not own or control. Oracle Corporation neither 
evaluates nor makes any representations regarding the accessibility of these Web 
sites. 

Other Information Sources
You can choose from many sources of information, including online documentation, 
training, and support services, to increase your knowledge and understanding of 
Oracle Mobile Field Service/Laptop.

If this guide refers you to other Oracle Applications documentation, use only the 
Release 11i versions of those guides.

Online Documentation
All Oracle Applications documentation is available online (HTML or PDF). Online 
help patches are available on OracleMetaLink.

Related Documentation
Oracle Mobile Field Service/Laptop shares business and setup information with 
other Oracle Applications products. Therefore, you may want to refer to other 
product documentation when you set up and use Oracle Mobile Field 
Service/Laptop.

You can read the documents online by choosing Library from the expandable menu 
on your HTML help window, by reading from the Oracle Applications Document 
Library CD included in your media pack, or by using a Web browser with a URL 
that your system administrator provides.

If you require printed guides, you can purchase them from the Oracle Store at 
http://oraclestore.oracle.com.

Documents Related to All Products

Oracle Applications User’s Guide
This guide explains how to enter data, query, run reports, and navigate using the 
graphical user interface (GUI) available with this release of Oracle Mobile Field 
Service/Laptop (and any other Oracle Applications products). This guide also 
includes information on setting user profiles, as well as running and reviewing 
reports and concurrent processes.
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You can access this user’s guide online by choosing "Getting Started with Oracle 
Applications" from any Oracle Applications help file.

Documents Related to Oracle Mobile Field Service/Laptop

Oracle Mobile Field Service User Guide for Field Service/Palm Handheld 
Devices
This guide explains how to use the Oracle Mobile Field Service/Palm application. It 
also describes the application components, key concepts, features, and functions, as 
well as the application’s relationships to other Oracle or third-party applications.

Oracle Mobile Field Service Implementation and Administration Guide for 
Field Service/Laptop
This guide explains how to implement and administer the Oracle Mobile Field 
Service/Laptop application. It covers software and hardware requirements, 
dependencies, implementation tasks, implementation verification, diagnostics and 
troubleshooting, administrative tasks, and migration tasks. 

Oracle Mobile Field Service Implementation and Administration Guide for 
Field Service/Palm Devices
This guide explains how to implement and administer the Oracle Mobile Field 
Service/Palm application. It covers software and hardware requirements, 
dependencies, implementation tasks, implementation verification, diagnostics and 
troubleshooting, administrative tasks, and migration tasks. 

Training and Support

Training
Oracle offers training courses to help you and your staff master Oracle Mobile Field 
Service/Laptop and reach full productivity quickly. You have a choice of 
educational environments. You can attend courses offered by Oracle University at 
any one of our many Education Centers, you can arrange for our trainers to teach at 
your facility, or you can use Oracle Learning Network (OLN), Oracle University's 
online education utility. In addition, Oracle training professionals can tailor 
standard courses or develop custom courses to meet your needs. For example, you 
may want to use your organization’s structure, terminology, and data as examples 
in a customized training session delivered at your own facility.
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Support
From on-site support to central support, our team of experienced professionals 
provides the help and information you need to keep Oracle Mobile Field 
Service/Laptop working for you. This team includes your Technical Representative, 
Account Manager, and Oracle’s large staff of consultants and support specialists 
with expertise in your business area, managing an Oracle9i server, and your 
hardware and software environment.

OracleMetaLink
OracleMetaLink is your self-service support connection with web, telephone menu, 
and e-mail alternatives. Oracle supplies these technologies for your convenience, 
available 24 hours a day, 7 days a week. With OracleMetaLink, you can obtain 
information and advice from technical libraries and forums, download patches, 
download the latest documentation, look at bug details, and create or update TARs. 
To use OracleMetaLink, register at (http://metalink.oracle.com).

Alerts: You should check OracleMetaLink alerts before you begin to install or 
upgrade any of your Oracle Applications. Navigate to the Alerts page as follows: 
Technical Libraries/ERP Applications/Applications Installation and 
Upgrade/Alerts.

Self-Service Toolkit: You may also find information by navigating to the 
Self-Service Toolkit page as follows: Technical Libraries/ERP 
Applications/Applications Installation and Upgrade.

Do Not Use Database Tools to Modify Oracle Applications Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data 
Browser, database triggers, or any other tool to modify Oracle Applications data 
unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and 
maintain information in an Oracle database. But if you use Oracle tools such as 
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of 
your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using 
Oracle Applications can update many tables at once. But when you modify Oracle 
Applications data using anything other than Oracle Applications, you may change a 
row in one table without making corresponding changes in related tables. If your 
tables get out of synchronization with each other, you risk retrieving erroneous 
information and you risk unpredictable results throughout Oracle Applications.
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When you use Oracle Applications to modify your data, Oracle Applications 
automatically checks that your changes are valid. Oracle Applications also keeps 
track of who changes information. If you enter information into database tables 
using database tools, you may store invalid information. You also lose the ability to 
track who has changed your information because SQL*Plus and other database 
tools do not keep a record of changes.

About Oracle
Oracle Corporation develops and markets an integrated line of software products 
for database management, applications development, decision support, and office 
automation, as well as Oracle Applications, an integrated suite of more than 160 
software modules for financial management, supply chain management, 
manufacturing, project systems, human resources and customer relationship 
management.

Oracle products are available for mainframes, minicomputers, personal computers, 
network computers and personal digital assistants, allowing organizations to 
integrate different computers, different operating systems, different networks, and 
even different database management systems, into a single, unified computing and 
information resource.

Oracle is the world’s leading supplier of software for information management, and 
the world’s second largest software company. Oracle offers its database, tools, and 
applications products, along with related consulting, education, and support 
services, in over 145 countries around the world.
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1
Understanding Oracle Mobile Field

Service/Laptop

This chapter describes what Oracle Mobile Field Service/Laptop is and how to 
administer it. This chapter also describes how the application is structured and how 
you can navigate in it.

1.1 What is Oracle Mobile Field Service/Laptop
Oracle Mobile Field Service/Laptop is part of the Oracle Field Service suite of 
products. See the "Overview of the Oracle Field Service Suite" on page 1-2 for 
complete details. This application is a disconnected-solution that enables field 
service representatives to service a customer in a fully automated and 
computer-efficient way. This means that schedules are received and updated in a 
timely manner and service requests are resolved quickly.

With the power of Oracle Mobile Field Service/Laptop, the information gap 
between the service organization and field service representatives is eliminated. For 
instance, field service representatives automatically receive the customer service 
history with the service request. Equipped with this information, they can better 
carry out their responsibilities at the customer site. Likewise, field service 
representatives are aware of any customer install base information since this is 
downloaded as part of the service request. This information is detailed and includes 
all the counter readings for the customer product. If replacement parts are need for 
a customer product, field service representatives can access the robust spare parts 
management feature of Oracle Mobile Field Service/Laptop. When field service 
representatives have completed a task, they can report the time, materials, and 
expenses incurred during their work. This information can then be sent back to the 
service organization at electronic speed so that an invoice can be given to the 
customer in a timely manner. All this automation enables you to reduce your 
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operating and administrative costs, thus giving you a competitive edge and 
ultimately increasing your service revenues.

Because the Oracle Mobile Field Service/Laptop runs on a laptop computer, it is 
highly mobile and usable. The service request, and all associated information, is 
stored locally on the laptop computer. This enables field service representatives to 
work in all places independent of network coverage. The dispatcher sends a job to 
field service representatives using Oracle Service Online, Oracle’s field service 
application. 

1.2 Overview of the Oracle Field Service Suite
The Oracle Field Service suite supports an automated process used by service 
organizations to manage their field service operations. It assists in the entire service 
process from taking the customer call to fixing and reporting on the problem at a 
customer site. The Oracle Field Service suite offers a range of products to meet your 
organization's business needs. The following table lists all the products in the suite:

Suite Application Description 

Customer Care Customer Care is not really a product of the Oracle 
Field Service suite but the Service Request form is 
delivered with the Oracle Field Service application. 
The Service Request form takes the customer's call for 
service and creates a service request.

CRM Foundation The products in CRM Foundation are essential to use 
Oracle Field Service. They are used to create tasks, 
territories, define resources, and help in the 
assignment of tasks to resources. CRM Foundation 
comes with Oracle Field Service.

Oracle Field Service This application assists in assigning tasks to service 
representatives, creating and dispatching daily 
schedules, monitoring progress, and reporting on 
material, expense, and labor transactions.

Scheduler This application enables optimization of scheduling 
capabilities of tasks to qualified resources. It takes into 
account driving time, distance, and part availability, 
and it creates part reservations.

Spares Management This application is used to provide additional logistics 
and planning features to manage a service parts 
inventory in a multi-location environment.
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1.3 The Oracle Field Service Process
The field service process has six basic steps. This process starts with the creation of a 
service request. The service request has at least one task, which is completed by a 
field service representative in the field. After completing a task, field service 
representatives electronically submit the task details to the home office, which is 
now able to create an invoice. The field service process is driven by the service 
request status and task status changes, electronically exchanged between the field 
service representatives and home office. 

The following table describes the six basic steps of the field service process:

Mobile Application Foundation This application consists of a mobile client and a 
central application. It provides data transport between 
the Oracle enterprise system and the Oracle mobile 
client database.

Oracle Mobile Field 
Service/Laptop

This application is a disconnected application typically 
installed at a service representative's laptop to receive 
his daily schedule and report on progress, material, 
expense, and labor.

Oracle Mobile Field Service/Palm This application is a disconnected application for a 
PalmTM handheld device so field service 
representatives can receive their daily schedule and 
report on progress, material, expense, and labor.

Steps Description 

1. Service request 
intake and 
validation

There are several ways to report a request for service. The 
customer can create the request by using the Web, Computer 
Telephone Integration (CTI), e-mail, or by dialing into a call 
center where an agent takes the call. A service request can also 
be created by field service representatives through a project or 
by a sales order (installation of a product). When the request is 
received, the customer, product and contract are checked in the 
validation step.

Suite Application Description 
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2. Service request 
screening and 
qualification 

After a service request is created, it is screened to avoid a field 
visit. The service request is analyzed by a support agent who 
searches the knowledge base for a solution. As an outcome of 
this process, the request may be closed, a part may be shipped to 
the customer, or the customer might ship the part for in-house 
repair. When a field visit is required, a task is created based on 
the problem description and action needed to resolve the 
problem. A definition for the parts necessary to resolve the task 
is also given. The creation of a task for installation or 
maintenance of customer product can be created automatically 
from a service contract or sales order.

3. Service request 
planning and 
dispatch

The tasks must be scheduled, assigned, and dispatched to the 
field service representative. The scheduling of the tasks is done 
based on various constraints such as skills, location, availability, 
and required parts. When the tasks assignment is done, the task 
or schedule is dispatched to the service representative. Field 
service representatives receive notification and progress on the 
task that is monitored.

4. Service request 
delivery and 
reporting

Once field service representatives receive an assigned task or 
schedule, they can begin service at the customer site. They 
report on progress, materials used and recovered, expenses, and 
labor time. Additionally, they can record counter readings and 
describe how the problem was resolved. It might be necessary to 
create new tasks or service requests if a field service 
representative cannot help the customer immediately. They can 
recover the product or product part for repair. All the reported 
information is used for billing the customer. Reporting on 
materials used also results in automatic replenishment of the 
inventory in the service vehicle.

5. Service request 
monitoring 

Unforeseeable events can occur that impact the progress of a 
task. In this case, escalations can be raised to indicate this 
situation.

6. Service request 
completion and 
billing 

When field service representatives complete a task, they sets the 
task status to COMPLETE and move on to the next task. The 
task information is checked by an agent at the home office for 
any service contract coverage and then an invoice is created. The 
inventories, sub-inventories, and install base are all updated.

Note: Depending on your service organization, the above steps 
can be separated or combined.

Steps Description 
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The component in step 4, Service request delivery and reporting, can be applied 
using Oracle Mobile Field Service/Laptop. In this application, the schedule is 
received by field service representatives on their laptop computer. They record 
counter readings and report on materials used, labor time, and expenses incurred.
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1.4 Navigation Path
This diagram shows the high-level structure of the Oracle Mobile Field 
Service/Laptop application. 

* You can order parts to replenish your subinventory. Also, you can transfer parts across 
subinventories. See "Ordering a Part" on page 3-75 for a complete description of these 
procedures.

The Preferences, Synchronize, Logout and Help text in the above figure represents 
the global buttons. See "Global Button Functionality" on page 3-87 for complete 
details. The Home, Calendar, Information, and Messaging headers in the above 
figure represent the four navigational tabs in the Oracle Mobile Field 
Service/Laptop application. The Home page is where you view how many tasks on 
your laptop computer are at a particular status. The Calendar page is where you 
view all of the scheduled tasks assigned to you for either the day or week, 
depending on the view you are in. The Information page is the central point for 
finding all the information about customer, service requests, and tasks. The 
Messaging page is where you send and receive messages to other people within 
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your organization. See the appropriate sections in this guide for more details about 
each page.
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2
Installing Oracle Mobile Field

Service/Laptop

This chapter describes what is needed to install and use the Oracle Mobile Field 
Service/Laptop application. It also describes how to launch the application.

2.1 Minimum Hardware Requirements
The following are the minimal hardware requirements necessary to run Oracle 
Mobile Field Service/Laptop:

� Computer: IBM-compatible with Pentium III processor

� Disk space: 1 GB

� Monitor: 256 color display

� RAM: 128 MB

� Other requirements: serial port, internet connection, mouse or pointer device

2.2 Minimum Software Requirements
The following are the minimal software requirements necessary to run Oracle 
Mobile Field Service/Laptop:

� Operating System: Windows NT 4.0 (Service Pack 5), Windows 98, Windows 
2000, Windows ME, or Windows XP

� Browser: Microsoft Internet Explorer, version 5.5 or later. This is the 
recommended browser for all Oracle HTML-based applications.
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2.3 Installing the Software
This section describes how to install the Web-to-Go server and Oracle9i Lite 
database, in addition to the Oracle Mobile Field Service/Laptop application. This 
additional software is necessary for Oracle Mobile Field Service/Laptop to operate.

Steps
Complete the following steps to install Oracle Mobile Field Service/Laptop on your 
laptop computer:

1. Open a Web browser window.

2. Open the following URL, where <Mobile Server> is the domain name or IP 
address of the Mobile Server:

http://<Mobile Server>/setup

For example: http://130.35.88.214/setup

3. Click the link to download the Mobile Client for Laptop setup program and 
save it.

If you are using Internet Explorer, right click with the mouse, choose the option 
Save target as and then click OK. Choose a location to save the setup program 
and then click Save.

4. From Windows Explorer, double-click the setup.exe file that you just 
downloaded.

Once started, the setup program prompts you to specify an install directory.

5. Choose an install directory.

For example, C:\ora_HOME and then click OK. The setup program downloads 
all the required components. Once the installation is completed, your browser 
will launch. If the browser does not launch automatically, the setup program 
box will have the Web-to-Go URL displayed on it. For example, 
http://my-laptop. In this case, click the URL. 

6. After the browser launches, log on using the same user name and password 
that you use for online applications.

Note: You can always use the URL http://localhost to access 
the Web-to-Go server without needing to know the name of the 
laptop computer.
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If the browser returns a "Page Not Found" error, check your proxy settings. In 
Internet Explorer, ensure that the Bypass Proxy for Local Addresses check box is 
selected under Tools > Internet Options > Connections > LAN 
Settings. Reload the page and try again. 

7. Click Go.

The Oracle9i Lite Client Initialization page opens.
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8. Click Next.

The Oracle9i Lite Client Synchronization page opens. The initial 
synchronization downloads the application and your initial set of data. The 
synchronization takes several minutes; therefore, do not exit the browser until 
the synchronization is complete.
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After synchronization completes, the browser displays the Oracle Mobile Field 
Service/Laptop Calendar page (Daily View).
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To start Oracle Mobile Field Service/Laptop after installing the application, see 
"Launching Oracle Mobile Field Service/Laptop" on page 3-3.



Using Oracle Mobile Field Service/Laptop 3-1

3
Using Oracle Mobile Field Service/Laptop

This chapter describes how to use all the functionality associated with the following 
pages:

� Calendar

� Information

� Messaging

� Home

3.1 Application Overview
As a field service representative, you will have the following general responsibilities 
when using Oracle Mobile Field Service/Laptop:

� Synchronize with the enterprise system at the beginning of each work day

� Review your calendar for the day

� Visit the customer and then update service requests and tasks

� Report service request and task details

The following is a general outline of how field service representatives may start and 
end their work day:

1. Launch Oracle Mobile Field Service/Laptop

See "Launching Oracle Mobile Field Service/Laptop" on page 3-3.

2. Synchronize Oracle Mobile Field Service/Laptop with the enterprise system

See "Synchronizing with the Enterprise System" on page 3-87.
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3. Review your calendar for the day and then set the status of the task on which 
you will be working.

See "Viewing and Opening Tasks" on page 3-6.

4. Create a personal task if you need to communicate any unavailability.

See "Creating a Personal Task" on page 3-21.

5. Record the time before visiting the customer site.

See "Creating and Deleting a Time Report Item" on page 3-50.

6. Open the task and view or change task information.

See "Viewing and Opening Tasks" on page 3-6 and "Viewing and Changing Task 
Information" on page 3-42.

7. Review customer information.

See "Viewing Customer Information" on page 3-22

� Review contract information.

See "Viewing Contractual Information" on page 3-36.

� Review service history information.

See "Viewing Service History" on page 3-40.

� Create or update a customer note if necessary.

See "Creating and Viewing Notes" on page 3-47.

8. Update or enter any service request information.

See "Viewing and Changing Service Request Information" on page 3-30.

9. Set any counter and counter properties.

See Setting Counters and Counter Properties on page 3-70.

10. Order or transfer any necessary parts needed to finish the task.

See Spares Management on page 3-74.

11. Record the time prior to leaving the customer site.

See "Creating and Deleting a Time Report Item" on page 3-50.

12. Record any materials used to complete the task.

See "Creating and Deleting a Material Report Item" on page 3-53.
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13. Record expenses incurred while completing the task.

See "Creating and Deleting an Expense Report Item" on page 3-61.

14. Repeat these steps for each task that you complete.

15. Finally, exit out of Oracle Mobile Field Service/Laptop.

See "Logging Out" on page 3-89.

3.2 Launching Oracle Mobile Field Service/Laptop
Complete the following steps to start Oracle Mobile Field Service/Laptop:

1. Choose Start > Programs > Oracle9i Lite > Web-to-Go 

The Web-to-Go icon appears in the system tray. The system tray is located in the 
Windows taskbar, usually at the bottom of the screen. The system tray contains 
the clock and miniature icons for easy access to system functions such as 
printer, modem, and volume control.

2. Double click on the Web-to-Go icon in the system tray.

Your internet browser opens the Oracle E-Business Suite login page.

3. Enter your user name and password in the appropriate fields and then click Go.
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The Calendar page (Daily View) opens. For a complete description of this page, 
see "Using the Calendar Page" on page 3-5.

In order to receive new data assigned to you, such as new tasks and service 
requests, you need to synchronize with the enterprise system. Likewise, to send 
the changes that you make, such as creating debrief lines and updating task 
statuses, you need to synchronize with the enterprise system.

4. Establish a telephone / internet connection for your laptop computer. 

5. Click the Synchronize button in the upper right corner of the page. 

The information on your laptop computer is synchronized with the enterprise 
system. Synchronizing your data can take a few minutes; therefore, do not abort 
this process. If the synchronization process fails, contact your system 
administrator. 
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3.3 Using the Calendar Page 
The Calendar tab is used to access the Calendar page, which can contain the daily 
or weekly listing of tasks assigned to you. The calendar gives you an immediate 
overview of all the tasks that need to be done for the day or week, along with 
pertinent task information, such as the scheduled task start time.

 

The calendar defaults to the date of the oldest active task. For example, if a task 
from yesterday has not yet been closed or completed, Oracle Mobile Field 
Service/Laptop will display this task first in the Calendar page. The tasks for the 
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current day are listed in ascending order based on the scheduled date/time, after 
any active tasks from previous days.

The following table describes what you can do from the Calendar page based on the 
page view:

3.3.1 Viewing and Opening Tasks 
The Calendar page is your starting point for each day of work. From it, you can 
learn which customers you are scheduled to visit, what tasks you will perform at 
each site, and retrieve any additional information about the listed tasks.

Steps
To view and open a task, complete the following steps: 

1. Click the Calendar tab to open the Calendar page. 

The Daily View is the default view of the Calendar page. 

To view the calendar of tasks for another day or week, see "Viewing a Past or 
Future Calendar" on page 3-9.

The Daily View of the Calendar page contains a table of tasks for the day. This 
table has multiple columns where you can access various task information.

The Weekly View of the Calendar page contains a table of tasks for the week. 
This table contains columns for each day of the week. A task appears in the 
column of the day for which it is assigned.

Calendar Function Daily View Weekly View

Navigate to the details of a selected task Yes Limited

Change the status of a task Yes No

Select a past or future calendar of tasks For a day For a week

Create a personal task Yes No

Note: As shown in the table above, you must be in the Daily View 
of the Calendar page in order to change the task status and create a 
personal task. The functionality in the Weekly View is an 
abbreviation of that of the Daily View.
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To open the Weekly View, click Weekly View in the Calendar tab.

2. Open the task either in the Daily View or Weekly View.

To Open the Task from the Daily View:

� From the Calendar: Daily View table, open the task by clicking one of the 
following:

– Request column—Click the desired service request number to view the 
service request details.

The Information page (Service Request Details view) opens. See "View-
ing and Changing Service Request Information"  on page 3-30 for a 
complete description of this page.

– Customer column—Click the desired customer name to view more 
information about the customer, such as the name and address of the 
customer. 

The Information page (Customer Details view) opens. See "Viewing 
Customer Information"  on page 3-22 for a complete description of this 
page.

– Task Name column—Click the desired task name to view a description 
of the task. 

The Information page (Task Details view) opens. See "Viewing and 
Changing Task Information" on page 3-42 for a complete description of 
this page.

– Product column—Click the desired customer product to view a 
description of the product.

The Information page (Search Results view) opens. See "Ordering a 
Part"  on page 3-75 for a complete description of this page.

The Calendar: Daily View table also provides the following information:

– Scheduled column—Where you can view the task scheduled start time

– Travel Time column—Where you can view the calculated or default 
travel time. 

– Task Number column—Where you can view the task number for a 
desired task.
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– Status column—Where you can view and specify the current task 
status. To specify the current task status, access the status drop-down 
list for the desired task and then make the appropriate selection.

Set the status of the task and then click Update to save the status to the 
local database on your laptop computer. Choose a status from the fol-
lowing table:

Typically, the status for a task progresses in the following order:

– Upon initial download to the laptop computer, a task has a status of 
"Assigned". 

– Once you review your schedule for the current day, change the status 
of "Assigned" tasks to "Accepted". 

– Before you start working on an "Accepted" task, change its status to 
"Working". 

– When you have successfully completed a "Working" task, change its 
status to "Completed".

To Open the Task from the Weekly View:

� If you haven’t done so already, click Weekly View in the Calendar tab. 

The Calendar: Weekly View table appears.

� From the Calendar: Weekly View table, open the task by clicking one of the 
following:

– Task name—Click the desired task name to view a description of the 
task. 

Task Status Description

Accepted Assign this status to a task once you have viewed the calendar and are ready 
to work on the task.

Assigned A task has this status when initially downloaded onto the laptop computer.

Cancelled Assign this status to a task that has been cancelled.

Closed Assign this status to a task that is now closed.

Completed Assign this status to a task once you have completed a task.

Rejected Assign this status to an assigned task that you are unable to accept.

Working Assign this status to a task once you have started to work on the task.
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The Information page (Task Details view) opens. See "Viewing and 
Changing Task Information" on page 3-42 for a complete description of 
this page.

– Customer name—Click the desired customer name to view more 
information about the customer, such as the name and address of the 
customer. 

The Information page (Customer Details view) opens. See "Viewing 
Customer Information"  on page 3-22 for a complete description of this 
page.

The Calendar: Weekly View table also provides the following information:

– Scheduled start time for a task

3.3.2 Viewing a Past or Future Calendar
Oracle Mobile Field Service/Laptop enables you to view the calendar of tasks for a 
past or future day or week. 

Steps
To view the calendar of tasks for a past or future day or week, complete the 
following steps:

1. Click the Calendar tab to open the Calendar page. 

The Daily View is the default view of the Calendar page. 

2. To change to the Weekly View, click Weekly View in the Calendar tab.

3. To go to the next or previous calendar of tasks, click the left or right arrow 
button. 

� In the Daily View, the tasks for the next or previous day appears.

� In the Weekly View, the tasks for the next or previous week appears.

4. To select a calendar day or week directly, click the calendar button near the date 
field in upper right portion of the Calendar page.

The calendar window opens.
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You can also type the date directly into the date field. If you type the date with 
the incorrect format, a warning message appears indicating this and then the 
date reverts back to its original value.

5. Use the month and year drop-down lists to display the desired month and year.

Use the left and right arrow buttons in the calendar window to go to the next or 
previous month.

6. Click on the desired date.

The calendar window closes and the selected date appears in the date field of 
Calendar page.

To exit the calendar window without selecting a date, click Cancel. To exit the 
calendar window and clear the date field of Calendar page, click Clear.

7. Click Go.

If you are in the Daily View, the task(s) for the selected date appears in the 
Calendar page. If you are in the Weekly View, the tasks for the week of the 
selected date appear in the Calendar page.

3.3.3 Using Quick Debrief 
Quick Debrief is a feature found in the Calendar page that enables you to view and 
specify general debrief information and specific labor time, expense, and material 
information from a single page. See Debrief Reporting on page 3-50 to learn more 
about debrief reporting.

Quick Debrief enables you to access debrief information for a specific service 
request. See Viewing a Past or Future Calendar on page 3-9 to choose a different 
service request. 



Using the Calendar Page

Using Oracle Mobile Field Service/Laptop 3-11

Steps
To access Quick Debrief, complete the following steps:

1. From the Calendar page, click the Quick Debrief page icon in the Calendar 
table, under the Quick Debrief heading.

The Quick Debrief page opens.

2. From the Problem drop-down list, specify the type of service request problem.

3. From the Resolution drop-down list, specify the type of service request 
resolution.

4. In the SRNotes field, click Add to open the Notes window and to add a service 
request note.

See "Creating and Viewing Notes" on page 3-47 for a complete description of 
this procedure.
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5. In the TaskNotes field, click Add to open the Notes window and add a task 
note.

See "Creating and Viewing Notes" on page 3-47 for a complete description of 
this procedure.

6. For any flexfields, complete these according to your needs.

7. To add a labor time report item for a task, complete the following steps:

� To change the default business process, make the appropriate selection from 
the Business Process drop-down list.

Note: The Business Process, Labor Type, and Service Date 
drop-down lists are mandatory. To specify the length of the task, 
either the Start Time and End Time fields are mandatory or the 
Duration field and UOM drop-down list are mandatory. Specify the 
length of time using one of these pairs, but not both.
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� To change the default labor type, make the appropriate selection from the 
Labor Type drop-down list.

� To change the default labor item, make the appropriate selection from the 
Labor Item drop-down list.

� To change the default service date, specify the appropriate information in 
the Service Date field.

Use the procedure, "Viewing a Past or Future Calendar" on page 3-9, 
beginning with step 4, to change the service date. The star next to the 
Service Date field indicates that this drop-down list is required. 

In the following steps, specify the amount of labor time used to complete the 
task. According to your business process, complete the steps for either the start 
and end times or duration.

� From the Start Time hour and minutes drop-down lists, select the time you 
started a task.

The Start Time hour drop-down list provides values for the 24-hour clock 
format. If you are selecting a time after 12:00 P.M., add twelve to the hour to 
get the 24-hour clock equivalent. For example, 4:30 P.M. would be entered 
as 16 hours and 30 minutes.

� From the End Time hour and minutes drop-down lists, select the time you 
ended a task.

Again, the hour drop-down list provides values for the 24-hour clock 
format.

� In the Duration field, enter the length of time the task took to complete.

� From the UOM drop-down list, select the unit of time that describes the 
value in the Duration field.

� From the Reason drop-down list, select the reason for spending the 
specified labor time on the task.

� Click Add.

Note: The labor item is optional. If you keep the Labor Item 
drop-down list blank, then it is mandatory that you specify values 
in the Start Time and End Time fields, but nothing in the Duration 
field and UOM drop-down list.
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The labor time report item is saved and added to the time report. In the 
table in the Time Reporting area, the new labor time report item is now 
listed.

To clear the information that you specified for the labor time report item, 
click Clear. To delete a labor time report item from the report, select the 
check box near the desired report item and then click Delete selected.

For an open or closed task that has not been synchronized, Oracle Mobile 
Field Service/Laptop enables you to delete a labor report item from the 
labor report.

8. To add an expense report item for a task, complete the following steps:

� To change the default business process, make the appropriate selection from 
the Business Process drop-down list.
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� To change the default business process, Customer Support, make the 
appropriate selection from the Business Process drop-down list. 

� To change the default expense type, make the appropriate selection from 
the Expense Type drop-down list.

� To change the default expense item, make the appropriate selection from 
the Expense Item drop-down list.

� To change the default service date, specify the appropriate information in 
the Service Date field.

Use the procedure, "Viewing a Past or Future Calendar" on page 3-9, 
beginning with step 4, to change the service date. 

� Specify the cost and currency that describes the expense. 

The Quantity field and UOM drop-down list are used together while the 
Cost field and Currency drop-down list are paired together. In your 
description, complete only one of these field-and-drop-down list 
combinations.

– Complete the Quantity field and UOM drop-down list if the pricing 
amount is unknown.

– In the Cost field, enter the cost of completing the task. In the Currency 
drop-down list, ensure that the default currency is correct. If necessary, 
change it to the correct currency. 

� In the Justification drop-down list, select the reason for spending the 
specified expense on the task.

� Click Add.

The expense report item is saved to your laptop computer. In the table in 
the Expense Reporting area, the new expense report item is now listed.

Note: The Business Process, Expense Type, and Expense Item, and 
Service Date drop-down lists are mandatory. To specify the expense 
of the task, either the Quantity filed and UOM drop-down list are 
mandatory or the Cost field and Currency drop-down list are 
mandatory. Specify the expense using one of these pairs, but not 
both.
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To clear the information that you specified for the expense report item, click 
Clear. To delete an expense report item from the report, select the check box 
near the desired report item and then click Delete selected.

For an open or closed task that has not been synchronized, Oracle Mobile 
Field Service/Laptop enables you to delete an expense report item from the 
expense report.

There are two versions of the Material Reporting area of the Quick Debrief page: 
one for used parts and the other for recovered parts. In both versions, there are 
default values for the Business Process and Transaction Type drop-down lists.

9. To add a material report item for a task, complete the following steps:

� To change the default business process, make the appropriate selection from 
the Business Process drop-down list.

The business process selection determines the selection in the Transaction 
Type drop-down list. The selection in this drop-down list determines 



Using the Calendar Page

Using Oracle Mobile Field Service/Laptop 3-17

whether fields and drop-down lists for a used or recovered part appear in 
the Material Reporting area of the Quick Debrief page. 

� To change the default transaction type, make the appropriate selection from 
the Transaction Type drop-down list. 

Adding a Used Part 

� Click Find without completing any fields or drop-down lists.

The Search Materials window opens.

� Click Find without completing any fields.

The Search Materials area appears in the Search Materials window.

� Select the desired part from the Search Materials area.

The Search Materials window closes and the selected material report item 
appears in the Used Part table.

� To change the default service date, specify the appropriate information in 
the Service Date field.

Use the procedure, "Viewing a Past or Future Calendar" on page 3-9, 
beginning with step 4, to change the service date.

� To change the default quantity, specify the correct value in the Quantity 
field.
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� To change the default unit of measure, specify the correct information in the 
UOM drop-down list.

� From the Reason drop-down list, select the reason for adding the specified 
part.

� Click Add.

The material report item is saved and added to the material report. In the 
table in the Material Reporting area, the new material report item is now 
listed.

To clear the information that you specified for the material report item, click 
Clear. To delete a material report item for a used part from the report, select 
the check box near the desired report item and then click Delete selected.

For an open or closed task that has not been synchronized, Oracle Mobile 
Field Service/Laptop enables you to delete a material report item from the 
material report.

Adding a Recovered Part

� Click Find without completing any fields or drop-down lists.

The Customer Products window opens.

� Select the desired service request.

The Customer Products window displays a recovered install base part.
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� Click OK.

The Customer Products window closes and the selected material report 
item appears in the Recovered Part table.

� To change the default service date, specify the appropriate information in 
the Service Date field.

Use the procedure, "Viewing a Past or Future Calendar" on page 3-9, 
beginning with step 4, to change the service date.

� To change the default quantity, specify the correct value in the Quantity 
field.

� To change the default unit of measure, specify the correct information in the 
UOM drop-down list.

� To change the default inventory, specify the correct information in the 
Inventory drop-down list.

� From the Reason drop-down list, select the reason for adding the specified 
part.

� Click Add.

The material report item is saved and added to the material report. In the 
table in the Material Reporting area, the new material report item is now 
listed.
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To clear the information that you specified for the material report item, click 
Clear. 

10. To delete a material report item for a recovered part from the report, select the 
check box near the desired report item and then click Delete selected.

For an open or closed task that has not been synchronized, Oracle Mobile Field 
Service/Laptop enables you to delete a material report item from the material 
report.

11. View sign off information.

The customer name, current date, and space for a signature appear at the 
bottom of the Quick Debrief page. You can print this page and have the 
customer sign off for the task in the signature area.

12. Click Calendar to return to the Calendar page.

Click Task Details to open the Information page (Task Details view) and view 
all the details for the task.



Using the Calendar Page

Using Oracle Mobile Field Service/Laptop 3-21

3.3.4 Creating a Personal Task
A personal task is a notice to the dispatcher that you will not be available for a 
particular time slot. A personal task is different from a task that is loaded onto your 
laptop, since it is not dispatchable or tied to a service request. For example, if you 
need to go to the dentist next week, you will create a personal task for it. This way, 
the dispatcher will know that you are not available during that time next week to 
service tasks.

Steps
To create a personal task, complete the following steps:

1. Click the Calendar tab to open the Calendar page. 

The Daily View is the default view of the Calendar page.

2. Click Create Personal Task.

The Calendar page displays the Create Personal Task view.

3. From the Type and Status drop-down lists, select the appropriate information.

4. Complete the Name field with the appropriate information.

5. Complete or modify any other fields in this window.

6. Click Create.

Oracle Mobile Field Service/Laptop creates a personal task and then returns 
you to the Calendar: Daily View of the Calendar page.

Note: The Type and Status drop-down lists are mandatory along 
with the Name field.
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3.4 Using the Information Page
The Information page is the central point for finding all the information about 
customers, service requests, and tasks. Whenever you request information from 
anywhere in the application, your request is linked to the Information page. This 
means that the Oracle Mobile Field Service/Laptop application will take you to the 
Information page when you search for information.

From the Information page, you can find information about the following:

� Customers

� Tasks

� Service requests

� Install base

� Inventory and order parts

From the Information page, you can also do the following:

� Create a service request

� Create a task

� Generate a report on tasks 

� Print out service reports 

3.4.1 Viewing Customer Information 
Before you visit a customer site, you need to know the address and contact 
information. 

You can obtain customer information from the following:

� The Information page

� The Calendar page, if a visit to that customer is scheduled (see "Using the 
Calendar Page"  on page 3-5)

� Using the Quick Find function from the Home, Calendar, and Messaging pages 
(see "Using the Quick Find Function"  on page 3-86)

This section describes how to use the Information page to obtain customer 
information. 
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Steps
Complete the following steps to view information about customers other than those 
who have a visit currently scheduled:

1. Click the Information tab to open the Information page.

2. From the View drop-down list, select Customer. 

3. In the Search field, type the % wildcard character and then click Go.

Customers appear under the Contents heading, on the left side of the page.

If you know the customer for which you want to search, enter all or part of the 
customer name in the Search field. Use the % wildcard to represent one or more 
unknown characters. 

To narrow the search to more specific criteria:

� From the View drop-down list, select Customer and then click Advanced. 

Additional fields are displayed on which you can search. 

� Complete one or more fields and then click Search.

Use the % wildcard to represent one or more unknown characters. 

The customer or those matching the specified criteria appear under the 
Contents heading, on the left side of the page.
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4. Click on the desired customer name.

The Information page displays the Customer Details view.
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The Information page (Customer Details view) displays the customer 
information, including contact information and any flexfields that are set up.

5. To view the customer product information for the customer, click on the person 
icon for the desired customer location.

The Information page displays the Customer Products view. This view list all 
the customer products for the customer.
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6. Click Close to exit the Customer Products view. 

7. In the Information page (Customer Details view), click Notes to view existing 
customer notes or to add a new customer note. 

See "Creating and Viewing Notes" on page 3-47 for a complete description of 
this procedure. 

3.4.2 Viewing Install Base Information
Oracle Mobile Field Service/Laptop enables you to view the location and product 
details for a customer product. Also, you are able to vies the configuration of the 
customer product. Finally, you are able to view and add customer product notes.

Steps
Complete the following steps to view install base information:

1. Click the Information tab to open the Information page. 
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2. From the View drop-down list, select Customer Product.

3. In the Search field, type the % wildcard character and then click Go.

Customer products appear under the Contents heading, on the left side of the 
page.

If you know the customer product for which you want to search, enter all or 
part of the customer product name in the Search field. Use the % wildcard to 
represent one or more unknown characters. 

To narrow the search to more specific criteria:

� From the View drop-down list, select Customer Product and then click 
Advanced. 

Additional fields are displayed on which you can search. 

� Complete one or more fields and then click Search.

Use the % wildcard to represent one or more unknown characters. 

The desired customer product or those matching the specified criteria 
appear under the Contents heading, on the left side of the page.

4. Click on the desired customer product.

The Information page displays the Installed Base Details view.
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5. Click Configuration.

The Customer Products window opens.
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6. Select the desired service request.

The Customer Products window displays a customer product description.

7. Click Cancel to return to the Information page (Installed Base Details view).

8. Click Notes to view existing customer product notes or to add a new customer 
product note. 
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See "Creating and Viewing Notes" on page 3-47 for a complete description of 
this procedure. 

3.4.3 Working with Service Requests
A service request is created when a customer contacts your organization with a 
problem. Typically, the customer representative analyzes the service request and 
assigns a task or tasks to it. Then the service request, along with all related 
information and tasks, are sent to field service representative. You can view the 
summary details of a service request in the calendar of the Calendar page. See 
"Viewing and Opening Tasks" on page 3-6 for a complete description of this 
procedure. 

This section describes how to create, view, and change a service request. A service 
request contains the following groups of information:

� General

� Contact

� Product

� Service request

� Credit card

3.4.3.1 Viewing and Changing Service Request Information
The service request contains practical information, including the problem and likely 
resolution. 

Steps
Complete the following steps to view service request information: 

1. Click the Information tab to open the Information page.

2. From the View drop-down list, select Service Request.

3. In the Search field, type the % wildcard character and then click Go.

Service requests appear under the Contents heading, on the left side of the 
page.

Note: The field service representative can create a service request 
when necessary. 
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If you know the service request for which you want to search, enter all or part 
of the service request name in the Search field. Use the % wildcard to represent 
one or more unknown characters. 

To narrow the search to more specific criteria:

� From the View drop-down list, select Service Request and then click 
Advanced. 

Additional fields are displayed on which you can search. 

� Complete one or more fields and then click Search.

Use the % wildcard to represent one or more unknown characters. 

The desired service request or those matching the specified criteria appear 
under the Contents heading, on the left side of the page.

4. Click on the name of the desired service request.

The Information page displays the Service Request Details view for the selected 
service request. 
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5. Under the Product header, you can enter or change information for the 
following:

� Product field—click the person icon next to this field to specify a new or 
different customer product. The Information page displays the Customer 
Products view.



Using the Information Page

Using Oracle Mobile Field Service/Laptop 3-33

Click the desired product code. 

The Information page displays the Service Request Details view, with the 
new product information in the Product field and Description drop-down 
list. Click Close to exit the Customer Products view without selecting a 
customer product.

� Serial Number field—enter the serial number of the customer product 
specified in the Product field and Description drop-down list.

� System Item and Installed Base radio buttons—specify the type of customer 
product you specified in the Product field and Description drop-down list.

6. Under the Service Request header, you can enter or change information for the 
following:

� Problem drop-down list—make a selection that describes the task problem. 

� Resolution drop-down list—make a selection that describes the task 
solution.
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� Customer PO Number field—enter the customer purchase order number in 
this field.

� Flexfields—if these fields are set up, complete them according to your 
needs.

To complete credit card information, see "Viewing and Entering Credit Card 
Information" on page 3-38.

To create a service request note, click Note. See "Creating and Viewing Notes" 
on page 3-47 for a complete description of this procedure.

To create a task, click Create Task. See "Creating a Task" on page 3-44 for a 
complete description of this procedure.

To view the service history, click Service History. See "Viewing Service History" 
on page 3-40 for a complete description of this procedure.

3.4.3.2 Creating a Service Request
When you are at a customer site, the customer may have an additional request. As 
an additional service, you can create a service request for this customer. 

You can create a service request for each of the following scenarios:

� Without having any product information 

� With a system item 

� With a known customer product (install base)

The service request contains the following detailed information:

� Request status

� Type

� Severity

� Urgency

� Problem resolution

� Customer product involved

� Installation address

� A summary of the problem or reason for request

There are two ways you can create a service request for a customer:

� Based on an existing service request which serves as a template
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� Based on no existing service requests where you have to enter all the necessary 
information

Steps
To create a service request, complete the following steps:

1. Click the Information tab to open the Information page.

As an alternative, you can click on the task number of the desired service 
request in the Calendar page. This action will take you to the Information page 
with service request information displayed for the desired task.

2. Choose the desired customer for which you want to create a service request.

See "Viewing Customer Information" on page 3-30 for a complete description of 
this procedure.

3. Click Create Service Request.

The Information page displays the Create Service Request view.
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To populate all the fields of the Create Service Request view based on an 
existing template, select a template from the Use the following task as template 
drop-down list. After you make this selection, you are able to change any field 
you want in the Create Service Request view.

4. To change the defaults in the Type, Status, Severity, and Urgency drop-down 
lists, make different selections.

5. Complete the Summary field with the appropriate information.

6. Complete any other fields in the Create Service Request view.

If the product is known, then select the Install Base Product check box and 
specify the product in the Product field.

7. Click Create.

The Information page displays the Service Request Details view. See "Viewing 
and Changing Service Request Information" on page 3-30 for a complete 
description of this page.

3.4.3.3 Viewing Contractual Information
Before starting a task, a field service representative should have as many details 
about the customer and task as possible. Part of these details is the contractual 
information. The field service representative uses this information to determine the 
following:

� Customer entitlements

� Contract coverage

Oracle Mobile Field Service/Laptop displays contractual information in a table 
format that you can reference for transaction billing types.

Steps
Complete the following steps to view contractual information:

1. Click the Information tab to open the Information page.

2. Choose the desired service request for which you want contractual information.

Note: The Type, Status, and Severity drop-down lists are 
mandatory along with the Summary field.
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See "Viewing and Changing Service Request Information" on page 3-30 for a 
complete description of this procedure.

3. Under the Contents heading, click the "+" button to the left of the desired 
service request. 

The task(s), field service request report, customer product(s), and contract are 
listed below the service request.

4. Click on the contract.

The Information page displays the Contract Line Details view.

 

The contract number appears in the Contract number field and the type of 
service covered by the contract appears in the Service name field. The service 
description code appears in the Service description field.

5. To change a business process, make a selection from the Business process 
drop-down list.

Under the Transaction Billing Types header is a table that describes each aspect 
of the contract. The contents of this table are determined by the business 
process that you select in the Business process drop-down list.

For example, you could have an Extended Notebook PC Service Program that 
covers eight transaction billing types, each with a maximum amount of 
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$100,000. The percent of the money covered by the service organization varies 
from transaction billing type. For instance, a loaner notebook computer can be 
provided under a Loaner transaction billing type with 10% coverage, so the 
service organization would only be responsible for 10% of the cost. If there was 
a repair estimate, then an Estimate Repair transaction billing type with 100% 
coverage could apply, and the service organization would not be responsible for 
any cost.

3.4.3.4 Viewing and Entering Credit Card Information
Oracle Mobile Field Service/Laptop enables you to record or update the following 
credit card information from the customer point-of-service:

� Credit card number

� Expiration date

� Credit card type

� Customer name

With this information saved, you do not have to re-enter it. The credit card 
information is encrypted so it is secure. Only the last four digits of the credit card 
number is visible in the application.

When you synchronize with the enterprise system, the credit card information is 
validated. See "Synchronizing with the Enterprise System" on page 3-87 for a 
complete description of this procedure.

Steps
Complete the following steps to view and enter credit card information:

1. Click the Information tab to open the Information page.

2. Choose the desired service request for which you want credit card information.

See "Viewing and Changing Service Request Information" on page 3-30 for a 
complete description of this procedure.

At the bottom of the Information page (Service Request Details view) is the 
credit card information.

Note: The credit card feature is set in a profile. Consult your field 
service administrator on the use of this feature.
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3. To record a customer’s credit card information, complete the desired fields and 
drop-down lists under the Credit Card Details header.

If the customer’s credit card information has already been entered, you can edit 
this information by making changes in the desired field(s) and drop-down 
list(s). The credit card information should be validated to ensure that the credit 
card number provided by the customer is a valid. 

4. Click Save.

To create a service request note, click Note. See "Creating and Viewing Notes" 
on page 3-47 for a complete description of this procedure.

To create a task, click Create Task. See "Creating a Task" on page 3-44 for a 
complete description of this procedure.

To view service history, click Service History. See "Viewing Service History" on 
page 3-40 for a complete description of this procedure.
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3.4.3.5 Viewing Service History
To best service the customer, field service representatives should review the 
customer’s service history prior to making a customer visit. You can request service 
history for either a customer or a customer product. Only tasks and service requests 
that are closed or completed can appear in the service history. The amount of 
service history gathered for a customer is determined in customer setup. Here, the 
administrator determines how many service requests will be used to create the 
service history. For example, the last three service requests may be compiled to 
create the service history.

Service history includes the following:

� Customer and contact details

� Product details (item or install base)

� Service request and task assignment details

� Reported time, material(s), and expenses for each customer visit

� Field service representative(s) who visited the customer previously

Steps
Complete the following steps to view service history:

1. Click the Information tab to open the Information page.

2. Choose the desired service request for which you want to view service history.

See "Viewing and Changing Service Request Information" on page 3-30 for a 
complete description of this procedure.

3. Click Service History at the bottom of the Information page (Service Request 
Details view).

The Information page displays the Service History view.
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3.4.4 Working with Tasks
A task is a unit of work within the service request. A task is created during field 
service request screening and qualification in the office, or when working out in the 
field. A task is related to a specific problem that needs to be resolved through a 
service request.

Update task status in order to keep your schedule up to date and to inform the 
dispatcher on the progress of your schedule. See "Viewing and Opening Tasks" on 
page 3-6 for a complete description of this procedure.

Oracle Mobile Field Service/Laptop enables you to view and change existing tasks 
and to create new ones.
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3.4.4.1 Viewing and Changing Task Information
For a task assigned to you, you need to retrieve information such as what is the 
problem and what parts and materials are needed. 

You can request task data from the following:

� The Information page

� Your daily calendar, if a visit to that customer is scheduled (see "Using the 
Calendar Page"  on page 3-5)

� Using the Quick Find function from the Home, Calendar, and Messaging pages 
(see "Using the Quick Find Function"  on page 3-86)

This section describes how to view and change task information. 

Steps
Complete the following steps to see information about any task, not just those that 
are scheduled:

1. Click the Information tab to open the Information page.

2. From the View drop-down list, select Task.

3. In the Search field, type the % wildcard character and then click Go.

For each customer, the service requests and tasks appear under the Contents 
heading, on the left side of the page.

If you know the task for which you want to search, enter all or part of the task 
name in the Search field. Use the % wildcard to represent one or more unknown 
characters. 

To narrow the search to more specific criteria:

� From the View drop-down list, select Task and then click Advanced. 

Additional fields are displayed on which you can search. 

� Complete one or more fields and then click Search.

Use the % wildcard to represent one or more unknown characters. 

The desired task or those matching the specified criteria appear under the 
Contents heading.

4. Click on the desired task to view the task details.

The Information page displays the Task Details view, which contains 
information about the selected task.
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If the task was escalated at the enterprise system, then the Escalated check box 
is selected.

5. To access Quick Debrief, click on the Quick Debrief link.

See "Using Quick Debrief" on page 3-10 for a complete description of this 
procedure.

6. In the Information page (Task Details view), under the Task header, ensure that 
the values in the fields and drop-down lists are correct.

Note: The fields and drop-down lists under the Task header are 
enabled as long as Cancelled or Completed is not specified in 
the Assignment Status drop-down list.
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The Planned Start Date and Planned End Date fields show the task 
start-and-end period according to the contract agreement. See "Viewing 
Contractual Information" on page 3-36 for complete contract details.

Depending on the business scenario your system administrator has chosen, you 
can enter the time that the visit is likely to take place in the Scheduled Start 
Date and Scheduled End Date fields. The actual start and end times for a task 
are listed in the time report. See "Creating and Deleting a Time Report Item" on 
page 3-50 for the actual time reporting.

Depending on the business scenario your system administrator has 
implemented, you may or may not be able to change the value in the Planned 
Effort field.

If flexfields are set up, change or complete them according to your needs.

7. Under the Task Assignment header, ensure that the selection in the Assignment 
Status drop-down list is correct.

8. Click Notes to view any existing task notes or to add a new task note. 

See "Creating and Viewing Notes" on page 3-47 for a complete description of 
this procedure. 

9. To save any changes to the task, click Update. 

Click Restore to return the original values to the Task Details view.

3.4.4.2 Creating a Task
There may be times when you need to create a new or additional task for a service 
request. For example, if you cannot complete a task or need support from a fellow 
field service representative, then you should create an additional task.

There are two ways you can create a task:

� Based on an existing task which serves as a template

� Based on no existing task where you have to complete all the desired fields

Note: The fields and drop-down lists under the Task Assignment 
header are enabled as long as Cancelled or Completed is not 
specified in the Assignment Status drop-down list.
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Prerequisites
A service request must already exist.

Steps
Complete the following steps to create a task:

1. Click the Information tab to open the Information page.

2. Choose the customer for which you want to create a task.

See "Viewing Customer Information" on page 3-30 for a complete description of 
this procedure.

3. Under the Contents heading, click the "+" button to the left of a customer name 
to view service requests for the customer.

4. Click the service request for which you want to create a task.

The Information page displays the Service Request Details view.
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� To specify the cause of the service request, select an item from the Problem 
drop-down list under the Service Request header.

� To specify the solution for the service request, select an item from the 
Resolution drop-down list under the Service Request header.

� Click Save to save the update.

5. Click Create Task at the bottom of the Service Request Details view.

The Information page displays the Create Task view.

 

Note: To populate all the fields of the Create Task view based on 
an existing template, select a template from the Use the following 
task as template drop-down list. After you make this selection, you 
are still able to change any fields that you want in the Create Task 
view.
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6. Select the appropriate information from the Type and Status drop-down lists.

7. Enter the task name in the Name field.

8. Complete or modify any other fields in this page.

9. Click Create.

The Information page displays the Task Details view for the new task. The new 
task also appears under the service request, on the left side of the page. See 
"Viewing and Changing Task Information" on page 3-42 for a complete 
description of this page.

3.4.5 Creating and Viewing Notes 
You can create and view notes for the following:

� Customer

� Customer product

� Service request

� Task 

For example, you may note that a power supply has to be replaced by a refurbished 
one.

A note includes the following:

� Note text

� Current date 

� Note type

� Note status

Note: A task that has the status of Assigned is automatically 
assigned to you, provided that this feature was implemented at 
setup. You can work on these tasks immediately, including entering 
debrief reports.

Note: The Type and Status drop-down lists are mandatory along 
with the Name field.
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Complete the following steps to create and view a note:

1. Open the appropriate page.

� To create and view a service request note, open the Information page 
(Service Request Details view).

See "Viewing and Changing Service Request Information" on page 3-30 for 
a complete description of this procedure.

� To create and view a task note, open the Information page (Task Details 
view).

See "Viewing and Changing Task Information" on page 3-42 for a complete 
description of this procedure.

� To create and view a customer note, open the Information page (Customer 
Details view).

See "Viewing Customer Information" on page 3-22 for a complete 
description of this procedure.

� To create and view a customer product note, open the Information page 
(Installed Base Details view).

See "Viewing Install Base Information" on page 3-26 for a complete 
description of this procedure.

2. To view any existing notes or to add a new note, click Notes. 

A window opens, divide into a Notes section and a Note details section. The 
Notes section lists all the notes for the entity in question. The Note details 
section shows the date of note creation and the note author.
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When you click on a note listed in the Notes section, the note text appears in the 
Note field of the Note details section. 

3. To create a new note, click Add note. 

A new Notes window opens.

 

4. From the Note type drop-down list, select the note type.
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5. From the Note status drop-down list, select the not status.

6. In the Note field, enter the note text. 

7. Click Save.

Oracle Mobile Field Service/Laptop opens a new, blank Notes window where 
you can add another note.

The next time you synchronize with the enterprise system, the saved note is 
added.

8. Add another note as described above or click Close to close the Notes window.

3.4.6 Debrief Reporting
After you complete a task, you can report the following information:

� Time Describes how much time a task took to complete.

� Materials Describes what materials were involved in the completion of a task. 
This includes both replacement and recovered parts. This 
information is used by the home office to replenish part inventories.

� Expenses Describes the expenses required to complete a task.

Once field service representatives record any or all of the above information, they 
can then upload this information to the enterprise system by synchronizing Oracle 
Mobile Field Service/Laptop. With this information now in the enterprise system, 
the home office can review and update the customer install base, spare parts 
inventory, and billing information.

3.4.6.1 Creating and Deleting a Time Report Item
When you have completed a task, enter the amount of time the task took to 
complete along with other related information. 

For a locally created time report item that has not been synchronized, Oracle Mobile 
Field Service/Laptop enables you to delete this report item from the time report.

Note: For a note to appear on a customer invoice, the note type 
must be "Invoice".
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Steps
Complete the following steps to create a time report item:

1. Click the Information tab to open the Information page.

2. Choose the desired task for which you want to create a time report.

See "Viewing and Changing Task Information" on page 3-42 for a complete 
description of this procedure.

3. Under the Contents heading, click the "+" button to the left of the desired task.

All the reports for the task are listed, including the time report.

4. Select Time Reporting. 

The Information page opens the Time Reporting view. This view contains 
default values for the Business Process, Labor Type, Labor Item, and UOM 
drop-down lists along with the Start Time and End Time fields.

Note: The actual times are determined when the field service 
representative sets a task assignment status to "Working" or 
"Closed." See "Viewing and Changing Task Information" on 
page 3-42 for a complete description of this procedure.

Oracle Mobile Field Service/Laptop uses the labor times that you 
enter to calculate the actual times. If there are no reported labor 
times, the application uses the time status change time stamp. 
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5. To change the default business process, Customer Support, make the 
appropriate selection from the Business Process drop-down list. 

6. To change the default labor type, make the appropriate selection from the Labor 
type drop-down list.

7. To change the default labor item, make the appropriate selection from the Labor 
item drop-down list.

In the following steps, specify the amount of labor time used to complete the task. 
Complete either steps 8 and 9 or steps 10 and 11, according to your business process.

Note: The Business Process, Labor Type, and Labor Item 
drop-down lists are mandatory. To specify the length of the task, 
either the Start Time and End Time fields are mandatory or the 
Duration field and UOM drop-down list are mandatory. Specify the 
length of time using one of these pairs, but not both.
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8. Specify a task start time:

� Click the calendar button near the Start Time field and then select the task 
start date.

For a complete description of this procedure, see "Viewing a Past or Future 
Calendar" on page 3-9.

� From the hour and minutes drop-down lists, select the time you started a 
task.

The hour drop-down list provides values for the 24-hour clock format. If 
you are selecting a time after 12:00 P.M., add twelve to the hour to get the 
24-hour clock equivalent. For example, 4:30 P.M. would be entered as 16 
hours and 30 minutes.

9. Specify a task end time:

� Click the calendar button near the End Time field and then select the task 
end date.

For a complete description of this procedure, see "Viewing a Past or Future 
Calendar" on page 3-9.

� From the hour and minutes drop-down lists, select the time you ended a 
task.

Again, the hour drop-down list provides values for the 24-hour clock 
format.

10. In the Duration field, enter the length of time the task took to complete.

11. From the UOM drop-down list, select the unit of time that describes the value in 
the Duration field.

12. Click Add.

The time report item is saved to your laptop computer. In the Summary of 
Reported Labor table, the new time report item is now listed.

To delete the newly created time report item, select the time report item and 
then click Delete selected.

3.4.6.2 Creating and Deleting a Material Report Item
After you complete a task, you can record what materials were used in the 
completion of the task. The home office uses this information to replenish or replace 
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needed materials, maintain the customers install base, and possibly invoice the 
customer for the materials used.

Initially, one item is associated with a service request. This can be an item from a 
customer's install base or an item from an inventory. One or more tasks are created 
for this service request and you can create a material report for each task. If multiple 
field service representatives are assigned to a task, then you can create multiple 
material reports for a task. You can also report several transactions in a material 
report. For each material transaction, a separate line is created in the report.

For a locally created material report item that has not been synchronized, Oracle 
Mobile Field Service/Laptop enables you to delete this report item from the 
material report.

Steps
Complete the following steps to create a material report item:

1. Click the Information tab to open the Information page.

2. Choose the desired task for which you want to create a material report.

See "Viewing and Changing Task Information" on page 3-42 for a complete 
description of this procedure.

3. Under the Contents heading, click the "+" button to the left of the desired task.

All the reports for the task are listed, including the material report.

4. Select Material reporting. 

The Information page displays the Material Reporting view. There are two 
versions of this view: one for recovered parts and the other for used parts. In 
both versions, there are default values for the Business Process and Transaction 
Type drop-down lists.
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5. To change the default business process, Customer Support, make the 
appropriate selection from the Business Process drop-down list. 

The business process selection determines the selection in the Transaction Type 
drop-down list. The selection in this drop-down list determines whether fields 
and drop-down lists for a used or recovered part appear in the Material 
Reporting view. 

6. To change the default transaction type, make the appropriate selection from the 
Transaction Type drop-down list. 

7. Click Find to locate and select the part.

If you have enough information to describe the part, you can complete the 
mandatory fields and any other fields and then click Add. (Mandatory fields 
are denoted with an asterisk [*])
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After you click Find, either the Information page displays the Search Materials 
view or the Customer Products window opens. If you are searching for a 
recovered install-base part, then the Customer Products window opens.

Selecting a Recovered Install Base Part

� Select the desired service request.

The Customer Products window displays a recovered install base part.
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� Click OK.

The recovered install base part appears in the Information page (Material 
Reporting view) under the Recovered Part header.

� Proceed to step 8.
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Selecting a Part that is Not Recovered and Install Base

� Click Find without completing any fields or the drop-down list.

The Search Results section appears in the Search Materials view of the 
Information page. This section displays all the possible parts for the task.
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If you know information about the desired part and would like to limit 
your search:

– Complete any of the fields and the drop-down list in the Information 
page (Search Materials view).

These fields are self-explanatory.

– Click Find.

The Information page (Search Materials view) displays the part(s) for 
the task under the Search Results header.

� Under the Search Results header, select the desired part.

The Search Materials view closes and the selected part appears in the 
Material Reporting view under the Used Part header or Recovered Part 
header, depending on the type of material report item you are reporting.
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8. In the Serial Number field of the Information page (Material Reporting view), 
enter an optional serial number for the part.

Add the serial number for a part that is serial-number based and has no serial 
number allocated to the item instance.

9. Click Add to add the selected material report item to the material report.

The material report item is saved to your laptop computer. The Information 
page (Material Reporting view) displays the part, along with a detailed 
description in the Summary of Reported Materials table. In this case, Item 
AS18947 is saved and added to the Summary of Reported Materials table.

To remove the selected part description from the Material Reporting view, click 
Clear instead of Add.
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To delete the newly created material report item, select the material report item 
from the Summary of Reported Materials table and then click Delete selected.

3.4.6.3 Creating and Deleting an Expense Report Item
After you complete a task, you can then enter information that describes the 
expenses associated with that task. Expenses may include such things as a meal and 
driving costs.

For a locally created expense report item that has not been synchronized, Oracle 
Mobile Field Service/Laptop enables you to delete this report item from the 
expense report.

Steps
Complete the following steps to create an expense report item:

1. Click the Information tab to open the Information page.
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2. Choose the desired task for which you want to create a expense report item.

See "Viewing and Changing Task Information" on page 3-42 for a complete 
description of this procedure.

3. Under the Contents heading, click the "+" button to the left of the desired task.

All the reports for the task are listed, including the expense report.

4. Click Expense reporting. 

The Information page displays the Expense Reporting view. This view contains 
default values for the Business Process, Expense Type, Expense Item, UOM, and 
Currency drop-down lists.
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5. To change the default business process, Customer Support, make the 
appropriate selection from the Business Process drop-down list. 

6. To change the default expense type, make the appropriate selection from the 
Expense Type drop-down list.

7. To change the default expense item, make the appropriate selection from the 
Expense Item drop-down list.

8. Specify the cost and currency that describes the expense. 

The Quantity field and UOM drop-down list are used together while the Cost 
field and Currency drop-down list are paired together. In your description, 
complete only one of these field-and-drop-down list combinations.

� In the Cost field, enter the cost of completing the task. In the Currency 
drop-down list, ensure that the default currency is correct. If necessary, 
change it to the correct currency. 

� Complete the Quantity field and UOM drop-down list if the pricing amount 
is unknown.

9. Click Add to add the selected expense report item to the expense report.

The expense report item is saved to your laptop computer. The Information 
page (Expense Reporting view) displays the part, along with a detailed 
description in the Summary of Reported Expenses table.

Click Clear to remove the selected part description from the Expense Reporting 
view.

Note: The Business Process, Expense Type, and Expense Item 
drop-down lists are mandatory. To specify the expense of the task, 
either the Quantity filed and UOM drop-down list are mandatory or 
the Cost field and Currency drop-down list are mandatory. Specify 
the expense using one of these pairs, but not both.
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To delete the newly created expense report item, select the expense report item 
and then click Delete selected.

3.4.6.4 Printing the Field Service Request Report
You can print out a document that summarizes all the information about time, 
material, and expenses for a service request. This is useful for leaving at the 
customer site, or for getting a signature. 

Steps
Complete the following steps to print the Field Service Request Report. 

1. Click the Information tab to open the Information page.

2. Choose the desired service request for which you want to print a report.

See "Viewing and Changing Service Request Information" on page 3-30 for a 
complete description of this procedure.
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3. Under the Contents heading, click the "+" button to the left of the service 
request for which you want to print a report. 

The field service request report, the customer product (install base), and task(s) 
appear under the selected service request.

4. Click Field Service Request Report. 

The summary appears, showing the Reported time, Reported material, and 
Reported expenses. The current date and space for a signature appear at the 
bottom of the report. 
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5. Click Print in your browser window. 

3.4.6.5 Printing the Field Service Task Report
You can print a report that summarizes all the information about time, material, and 
expenses for a task. This is useful for leaving at the customer site, or for getting a 
signature. 

The time, material, and expenses report information that you entered for a task is 
listed in the Field Service Task Report under descriptive headers. This information 
is limited to what you recorded for a particular task.

Steps
Complete the following steps to print the Field Service Task Report: 

1. Click the Information tab to open the Information page.

2. Choose the desired task for which you want to print a report.
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See "Viewing and Changing Task Information" on page 3-42 for a complete 
description of this procedure.

3. Under the Contents heading, click the "+" button to the left of the desired task to 
list all the task reports, including the Field Service Task Report.

4. Click Field Service Task Report. 

The summary appears, showing the reported time, material, and expenses. The 
customer and task details are also shown. The customer name, current date, and 
space for a signature appear at the bottom of the Field Service Task Report for 
customer sign off. 
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5. Click Print in your browser window. 

3.4.7 Setting Counters and Counter Properties
You can log a service request for a customer product that contains a counter. A 
counter helps a service representative determine how much work was done before a 
customer product was serviced. A copier having a number-of-copies counter is an 
example of this.

On the Information page, there can be multiple customer product counters, each 
with multiple readings. From these multiple readings, you can learn the service 
history of the customer product. You can also create new readings for a customer 
product counter. You can reset a reading as well as make miscellaneous readings. A 
miscellaneous reading can be a value used for testing a customer product. For 
example, an engineer who is fixing a copier may make ten test copies after 
completing the service. The copy counter value increases by ten, but he does not 
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want the customer to pay for the test copies. Therefore, the field service 
representative can state a miscellaneous reading of ten.

Finally, you can enter counter properties. Counter properties describe something 
about the customer product counter.

Steps
Complete the following steps to enter a counter reading and set the counter 
properties:

1. Click the Information tab to open the Information page.

2. Choose the desired customer product for which you want to enter a counter 
reading and set the counter properties.

See "Viewing Install Base Information" on page 3-26 for a complete description 
of this procedure.

3. Under the Contents header, click the "+" button to the left of the desired 
customer product to view the counter.

4. Click on the customer product counter.

The counter readings for the selected customer product appear in the Counter 
Readings view of the Information page. These counter readings are for specific 
dates.

Note: Only customer products with the "+" button contain a 
customer product counter.
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5. Click New Reading.

The Information page displays the Counter Reading view.
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6. Enter the appropriate information in the Date and Reading fields.

7. Complete or change any other fields in this page.

� Make the appropriate selection from the Misc. Reading Type drop-down list 
and complete the Misc. Reading field to make miscellaneous readings.

� Select the Reset Flag check box and then complete the Pre-reset Last 
Reading and Post-reset First Reading fields to reset the counter.

Pre-reset is the last counter value before the reset of the counter. Post-reset 
is the first new reading after the reset.

8. Complete the property fields for your customer product.

9. Click Save.

Note: The Date and Reading fields are mandatory. The date is the 
date you take a reading and the reading is the counter value that 
you want to record.
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Oracle Mobile Field Service/Laptop returns to the Counter Readings view of 
the Information page where the new counter reading is listed.

3.4.8 Spares Management
Oracle Mobile Field Service/Laptop enables you to manage the parts inventory that 
you can use in the repair or replacement of parts for a service request. The parts in 
inventory are known as spares and their management is known as spares 
management. Spares management is a critical process in field service. Spares are not 
only stored in the warehouse, but also inside the truck of a field service 
representative. It is therefore crucial to know where spares are located and how 
soon a field service representative can have them. In spares management, Oracle 
Mobile Field Service/Laptop allows you to do the following:

� Oversee the inventory stocked in the truck

� Manage spare parts

� Order and transfer parts

� Oversee defective parts that need to be sent back

� Maintain stock levels and install base
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� Stay current with business information

� Print out service reports (time, material, expenses) for a customer

3.4.8.1 Ordering a Part
Oracle Mobile Field Service/Laptop enables you to order parts from inventories 
assigned to you and those that are not assigned to you (sub-inventories). The latter 
case requires you to do a advanced search where you supply specific information 
about the desired part.

Prerequisites
� Desired part must already exist, either in the vehicle or at some other location 

(only applicable if Spares Management is being used). See the Oracle Mobile 
Field Service Implementation and Administration Guide for Field Service/Laptop for 
details about Spares Management.

� Desired part must be defined as "orderable".

Steps
Complete the following steps to order a part:

1. Click the Information tab to open the Information page.

2. From the View drop-down list, select Inventory.

3. In the Search field, type the % wildcard character and then click Go.

Inventories appear under the Contents heading, on the left side of the page.

If you know the inventory for which you want to search, enter all or part of the 
inventory name in the Search field. Use the % wildcard to represent one or more 
unknown characters. 

To narrow the search to more specific criteria:

� From the View drop-down list, select Inventory and then click Advanced. 

Additional fields are displayed on which you can search. 

� Complete one or more fields and then click Search.

Note: You can specify an inventory not assigned to you if it 
contains the desired part. In this case, continue with the following 
steps to narrow the search.
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Use the % wildcard to represent one or more unknown characters. 

The desired inventory or those matching the specified criteria appear under 
the Contents heading, on the left side of the page.

4. Under the Contents heading, click the "+" button to the left of the desired 
inventory to view the inventory items.

5. Click on an inventory.

The inventory items for the selected inventory appear in the Search Results 
view of the Information page.

6. In the Select column, click the button of the desired part and then click Order.

The Information page displays the Order an Item view.

Click Transfer to transfer a part. See "Transferring a Part" on page 3-77 for a 
complete description of this procedure.
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7. Complete the Quantity field with the appropriate information.

8. Select the appropriate information from the UOM (Unit Of Measure), 
Subinventory, and Shipment location drop-down lists.

9. Complete the Need by date field to specify a part delivery date.

10. Click Save to place the order.

Click Restore to cancel the order.

3.4.8.2 Transferring a Part
This section describes how to transfer a part from one sub-inventory to another. 

Note: The Quantity field along with the UOM, Subinventory, and 
Shipment location drop-down lists are mandatory. The shipment 
location is where you want the part delivered.



Using the Information Page

3-78 Oracle Mobile Field Service User Guide for Laptops

Steps
Complete the following steps to transfer a part from a sub-inventory:

1. Click the Information tab to open the Information page.

2. Choose the desired inventory from which you want to transfer a part.

See "Ordering a Part" on page 3-75 for a complete description of this procedure.

3. From the Select column in the Information page (Search Results view), click the 
button of the desired part and then click Transfer.

The Information page displays the Transfer Parts view.

 

Click Order to order a part. See "Ordering a Part" on page 3-75 for a complete 
description of this procedure.

4. From the Subinventory drop-down list, select the subinventory from which you 
want to transfer a part.
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5. From the To subinventory drop-down list, select the destination subinventory 
where you want transfer a part.

6. From the Quantity field, specify the amount of parts you want to transfer.

7. From the UOM drop-down list, select the unit of measure for the amount.

8. From the Reason drop-down list, select the reason for the transfer.

9. In the Reference field, specify the transfer reference.

10. Click Add.

A summary of the part transfer appears in the Transfer Lines table.

Click Cancel to exit without saving.

3.4.8.3 Viewing Part Order Details
Once a part is ordered, you can view the details regarding this part.

Prerequisites
A part must be ordered to view the order details.

Steps
Complete the following steps to view part order details:

1. Click the Information tab to open the Information page.

2. From the View drop-down list, select Order.

3. In the Search field, type the % wildcard character and then click Go.

Item descriptions appear under the Contents heading, on the left side of the 
page. These descriptions include the item number, status, and requirement 
number

If you know the item for which you want to search, enter all or part of the item 
name in the Search field. Use the % wildcard to represent one or more unknown 
characters. 

To narrow the search to more specific criteria:

Note: The Subinventory, To subinventory, Quantity, and UOM 
drop down lists are mandatory.
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� From the View drop-down list, select Order and then click Advanced. 

Additional fields are displayed on which you can search. 

� Complete one or more fields and then click Search.

Use the % wildcard to represent one or more unknown characters. 

The desired item or those matching the specified criteria appear under the 
Contents heading, on the left side of the page.

4. Click on the name of the desired item.

A detailed description for the selected item appears in the Item Order Details 
view of the Information page.
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3.5 Using the Messaging Page 
Oracle Mobile Field Service/Laptop enables you to send and receive messages to 
other people within your organization. This messaging function facilitates 
communication among field service employees. It can be set up to send messages 
among all Field Service users, or among the members of one team. 

You can use this page to send or receive messages. You can use this to ask for 
support or additional information.

3.5.1 Viewing Received Messages
After you synchronize with the enterprise system, you can check to see if you have 
received any messages. 

Steps
Complete the following steps to read messages that you have received, and to 
delete messages that you have read:

1. Click the Messaging tab to open the Messaging page.

2. Ensure that the Inbox subtab is selected. 

3. To read a message, click on the message subject in the Subject column. 

A window opens showing the complete message. A blue icon next to the 
Subject indicates that the message has an attachment. 
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4. To reply to a message, click Reply. 

A new message with a blank Message field appears. The subject and recipient 
fields are already completed. 

5. To delete a message, select the check box to the left of the desired message and 
then click Delete selected. 

The check box is in the Select column.

3.5.2 Writing and Sending New Messages
When you need information from one of the other members of the field service 
organization, you can ask for it by sending a message. 

Steps
Complete the following steps to write and send messages to others people in your 
field service organization: 

1. Click the Messaging tab to open the Messaging page.

2. Click the New subtab. 



Using the Messaging Page

Using Oracle Mobile Field Service/Laptop 3-83

3. From the To drop-down list, select the recipient’s name. 

4. In the Subject field, enter a title or brief summary of the message. 

5. Change the information in the Priority drop-down list, if necessary. 

6. In the Message field, enter the text of the message. 

Messages can be up to 255 characters long. 

7. Click Send to send the message. 

3.5.3 Viewing Sent Messages
In the Messaging page, you can ensure that a message you wrote has been sent to 
the intended person(s) in your field service organization.

Steps
Complete the following steps to view the messages you have sent:

1. Click the Messaging tab to open the Messaging page.

2. Click the Outbox subtab. 
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The messages you have recently sent appear. 

3. Click on the recipient’s name in the To column to see the user IDs of the other 
mobile users. 

4. Choose the recipient’s name.

5. Click on the message in the Subject column to see the text of the message that 
you sent. 
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3.6 Using the Home Page
The Home page is updated with the number of task at a particular status each time 
you synchronize with the enterprise system. 

Steps
Complete the following to access the Home page:

� Click the Home tab to open the Home page.

In this page, you can view the Tasks Summary table. This table lists how many 
tasks are at a particular status.
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3.7 Using the Quick Find Function
You can perform a quick find from the Home, Calendar, and Messaging pages. A 
quick find allows you to locate any of the following:

� Customer

� Customer product

� Inventory

� Item

� Order

� Personal task

� Service request

� Task

Steps
To do a quick find, complete the following steps from either the Home, Calendar, or 
Messaging pages:

1. From the Quick Find drop-down list, select the type of information for which 
you want to search. 

2. In the search field, enter the word or numbers for which to search.

Use the % wildcard to represent one or more unknown characters. 

3. Click Go.

The Information page opens and the search results are displayed in an outline 
on the left side of the page.

To narrow the search to more specific criteria:

� From the Quick Find drop-down list, select a value and then click 
Advanced Search. 

Additional fields appear that correspond to the type of information you 
entered in the Quick Find drop-down list. 

� Complete one or more fields and then click Search. 

Use the % wildcard to represent one or more unknown characters.
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3.8 Global Button Functionality
The global buttons are located in the upper right corner of each page in the Oracle 
Mobile Field Service/Laptop application. 

3.8.1 Preferences Button
Click the Preferences button to view your profile settings. Profile options are set by 
the system administrator at the home office. 

3.8.2 Synchronizing with the Enterprise System
In order to receive new data assigned to you, such as new tasks and service 
requests, you need to synchronize with the enterprise system. Likewise, to send the 
changes that you have made, such as creating debrief lines and updating task 
statuses to the enterprise system, you need to synchronize with the enterprise 
system.

Steps
Complete the following steps to synchronize Oracle Mobile Field Service/Laptop 
information with the enterprise system:

1. Establish a telephone / internet connection for your laptop computer. 

2. Click the Synchronize button in the upper right corner of the page. 

The Oracle9i Lite Client Synchronization page opens.
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The information on your laptop computer is synchronized with the enterprise 
system. Synchronizing your data can take a few minutes; therefore, do not abort 
this process. If the synchronization process fails, contact your system 
administrator. 

After synchronization completes, the browser displays the Oracle Mobile Field 
Service/Laptop Calendar page.
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3.8.3 Obtaining Online Help
The online help for the Oracle Mobile Field Service/Laptop application is an online 
version of the Oracle Mobile Field Service User Guide for Laptops.

Steps
Complete the following steps to obtain online help:

1. Click the Help button in the upper right corner of any page. 

Oracle Mobile Field Service/Laptop displays an online version of the Oracle 
Mobile Field Service User Guide for Laptops.

2. Navigate through the hyperlinks to find the desired information.

3.8.4 Logging Out
When you have finished working in Oracle Mobile Field Service/Laptop, log out of 
the application. 
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Prerequisites
Save all data and be ready to exit the application.

Steps
Do the following to log out of Oracle Mobile Field Service/Laptop:

� Click the Logout button in the upper right corner of any page. 

Oracle Mobile Field Service/Laptop checks that all data has been correctly 
saved and then closes. The application returns you to the login page. 
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A
Setting up Schedules and Responsibilities

The administrator can organize the Oracle Mobile Field Service/Laptop application 
in several different ways, depending on how much control a field service 
representative is given over his schedule. This appendix describes the different 
levels of control field service representatives can exercise when doing their job.

A.1 Conform to the Schedule
Field service representatives can only work on one job at a time, and is given a 
schedule that the dispatcher plans. For instance, the following tasks may be 
assigned to a field service representative:

� task 1: 8:00 Installation at Customer A

� task 2: 9:00 Repair on-site at Customer B

� task 3: 10:00 Installation at Customer C

The field service representative first needs to finish task 1 before going on to task 2. 
He needs to follow the pre-defined order of the dispatcher. The field service 
representative cannot reschedule tasks, but can reject a task. 

This setup gives the dispatcher control over the daily schedule of the field service 
representative. The dispatcher sets up the tasks, including what time and where the 
field service representative is to be at all times.
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A.2 Order of Task Completion
If you send more than one field service representative to perform a task, make sure 
that you schedule only one task assignment at a time, because multiple task 
assignments can lead to conflicts. For example, suppose you have a task that 
requires three field service representatives. You set up the task and then you send it 
to the calendars of all three representatives. It now appears on their calendars. 
However, if one of your field service representatives changes the time for his task, 
that would affect the calendar of the other two representatives. To avoid this, you 
must create three tasks, one for each representative.

Field service representatives can complete their scheduled tasks under different 
scenarios.

Scenario 1: Complete Scheduled Tasks in Pre-determined Order
In this scenario, the field service representative works on one job at a time and 
conforms to the dispatched schedule.

Scenario 2: Complete One Scheduled Task at a Time in Any Order
In this scenario, the field service representative works on a single job at a time and 
does not conform to the dispatched schedule.

Scenario 3: Complete Multiple Scheduled Tasks in Any Order
In this scenario, the field service representative works on multiple jobs at a time and 
does not conform to the dispatched schedule.

Scenario 2 and Scenario 3 gives field service representatives control over their day. 
The dispatcher sends the tasks and locations to the field service representative, and 
the service representative then decides when to perform each task. This scenario 
works well in an environment where each task requires only one field service 
representative. For example, if a field service representative has a dental 
appointment, he can arrange the time he wants to be at the customer site near his 
dentist. Field service representatives are expected to complete all the tasks on the 
day they were assigned. If they are unable to complete a scheduled task, they can 
reject it and then the dispatcher will re-schedule the task for the next day.
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